
CorelTRACE Help Contents
Help topics for CorelTRACE are divided into eight categories represented by the icons below.

To select a category with the mouse, point to its icon, then click. With the keyboard, press Tab to highlight 
the category you want, then press ENTER. To return to this screen, select the Contents button at the top 
of the Help window.

   

   

See also Using help.



Menus
Click a menu name to see the menu commands. Click a command to see a description of the
command.



 How to...
Scan images
Prepare images for tracing
Edit an image in CorelPHOTO-PAINT
Change the default paint program
Trace part of an image
Trace part of an image with the Magic Wand
Trace multiple images
Add files for batch tracing
Remove a file from the Batch Files list
Choose the appropriate tracing method
Create custom tracing settings
Select custom tracing settings
Use Optical Character Recognition (OCR)
Import traced images into CorelDRAW
Use colors
Use the Mosaic Roll-Up



Working with Colors
Using Colors

Choosing a tracing color
Choosing a color from the screen image

Color Palettes
Opening a color palette
Saving a color palette
Deleting a color from a palette
Rearranging colors in the palette
Creating custom process colors
Adding a tint of spot color to the palette



 Get Started with CorelTRACE

Using help
Why use CorelTRACE?
What to trace
Obtain an image
Work with menus
Choose tools
Work with dialog boxes
Work with roll-up windows
Start and exit CorelTRACE
Open an image
Open a resampled image
Open a cropped image
Trace an image: The Basics
Stop the tracing process
Save a traced file
Save a bitmap image
Save traced text 
File formats



Screen



 Tools and screen buttons
Click a tool or button for information on how it works.



Technical Support

The Technical Support Help file contains information pertaining to:

· Corel Support Services
· Common Error Messages
· Import and Export File Filter information
· INI files
· and other technical information

Please click on the highlighted text below to access the Technical Support Help file. 

Technical Support



Shortcuts
Menu keys

Help shortcut keys

Dialog box keys

Cursor movement keys

Editing keys

Window keys

System keys



Menu Keys
Press For

File menu Ctrl + O Open...
Ctrl + S Save Trace
Alt + F4 Exit

Edit menu Ctrl + Z Undo
Ctrl + X Cut
Ctrl + C Copy
Ctrl + V Paste
DEL Clear

View menu Ctrl + W Refresh Window

Main Screen Alt + F File menu
Alt + E Edit menu
Alt + V View menu
Alt + T Trace menu
Alt + H Help menu















Cursor Movement Shortcut Keys
Key(s) Function

End Moves the cursor to the end of a text 
box or field

Home Moves the cursor to the beginning of a 
text box or field

Ctrl+Right 
Arrow

Moves the cursor to the end or to the 
next word in a text box or field

Ctrl+Left Arrow Moves the cursor to the beginning or to 
the previous word in a text box or field



Dialog Box Shortcut Keys
Key(s) Function

Tab Moves from field to field (option to option)
from left to right and top to bottom.

Shift+Tab Moves from field to field in reverse order
Alt+letter key Moves to the option or group whose 

underlines letter matches the type one
Direction Key Moves from option to option within a 

group of options
Enter Executes a command button

Or, chooses the selected item in a list box 
and executes the command.

Esc Closes a dialog box without completing 
the command (behaves like the CANCEL 
button)

DOWN ARROW Opens a drop-down list box
Alt+UP or DOWN 
ARROW

Selects item in a drop-down box

SPACEBAR Clears a text box in which the text is 
highlighted.
Checks or clears a check box.

Shift+DIRECTION    key Extends the selection in a text box
Shift+Home Extends the selection to the first 

character in a text box
Shift+End Extends the selection to the last character

in a text box



Editing Keys
Key(s) Function

Backspace key Deletes the character to left of the 
cursor.
Or, deletes highlighted (selected) text.

Delete key Deletes the character to the right of the 
cursor.
Or, deletes highlighted (selected) text.



Help Shortcut Keys
Key(s) Function

F1 Displays the Help Contents for 
CorelTRACE.    If the Help window is 
already open, the Using Help topic 
appears.

Shift + F1 Changes the cursor to a question mark 
and arrow so that you can get help on a 
particular menu or tool item by clicking 
the item itself.

Ctrl + F1 Displays the Search for Help on dialog 
box.    It is used to find help topics that 
correspond to a particular subject.    Type
the subject name and choose an 
associated topic.



System Keys
The following keys can be used in any window, regardless of the application you are using.

Key(s) Function

Ctrl+Esc Switches to the Task List
Alt+Esc Switches to the next application window 

or minimized icon, including full screen 
programs

Alt+TAB Switches to the next application window,
restoring applications that are running 
as icons.

Alt+PrtSc Copies the entire screen to the 
clipboard.

Ctrl+F4 Closes the active window
F1 Displays the Help Contents screen for 

the application

Window Shortcut Keys
The following shortcut keys are available in a any window.

Key(s) Function

Alt+SPACEBAR Opens the Control menu for an application 
window.

Alt+Hyphen Opens the Control menu for a document 
window.

Alt+F4 Closes the active window.
Alt+Esc Switches to the next application window or 

minimized icon, including full screen 
programs

Alt+Tab Switches to the next application window, 
restoring applications that are running as 
icons.

Alt+Enter Switches a non-Windows application 
between running in a window and full 
screen

DIRECTION key Moves a window when you have chosen 
Move from the Control    menu.
Changes the size of a window when you 
have chosen Size from the Control menu.



Restore command (Control menu)
Returns the CorelTRACE or Help window to the size and location it had before you chose the 
Control Minimize or the Control Maximize command.
You can also restore a window by clicking on its Restore button

· Does not affect a window moved or resized with the Control Move or Control Size 
commands.



Move command (Control menu)
Use to move the CorelTRACE or Help window with the Direction keys on the keyboard. 

· This command is unavailable if the window is maximized.
· You can use this command to move Application icons and dialog boxes that have a 

Control menu.

For more information, see your Microsoft Windows User's Guide.



Size command (Control menu)
Use to resize the CorelTRACE or Help window with the Direction keys on the keyboard.

· This command is unavailable if the window is maximized.

For more information see your Microsoft Windows User's Guide.



Minimize command (Control menu)
Shrinks the CorelTRACE or Help window to a small icon at the bottom of the screen.

· Using the Control Minimize command is equivalent to clicking on the Minimize button 
with the mouse.

· You can use the Control Restore command to restore the minimized window to its 
former size.



Maximize command (Control menu)
Enlarges the CorelTRACE or Help window to fill the entire screen.

· Using the Control Maximize command is equivalent to clicking on the Maximize icon 
with the mouse. 

· You can choose the Control Restore command or click on the Restore icon to return the 
window to its former size.



Close command (Control menu)
Closes the CorelTRACE or Help window. 

· Closing CorelTRACE is the same as choosing Exit.
· Double-clicking on the Control Menu icon  is equivalent to choosing the Control Close 

command. 



Switch To command (Control menu)
Opens the Task List which lists all the applications currently running on your system.

Dialog Box Options

Switch To

Opens the selected application.
End Task

Closes the selected application.
Cancel

Closes the Task List.
Cascade

Overlaps all open applications so that their Title bars are visible.
Tile

Sizes all open applications to fit on the screen.
Arrange Icons

Arranges the icons of all minimized applications evenly across the bottom of the 
screen. 



Maximize button
Clicking on the Maximize button expands the active window to fill the entire screen. After 
you expand a window, the button changes to the Restore button . Use the Restore button 
to return the window to its former size.

· You can also maximize a window by choosing the Control Maximize command.
· You can also restore a maximized window to its former size by choosing the Control 

Restore command.



Minimize button
Clicking on the Minimize button shrinks the window to an icon at the bottom of the screen.

· As an icon, CorelTRACE stays in memory, but its window does not take up space on 
your screen.

· To restore the window, double-click on its icon or click once on the icon and choose 
Control Restore.



Restore button 
Restores a window enlarged with the Maximize button or the Control Maximize command to 
its previous size and location.

· You can also restore a window by choosing the Control Restore command.
· Does not affect a window moved or resized with the Control Move or Control Size 

commands.



Open command (File menu)        
Displays the Open Files dialog box for selecting a bitmap file(s) for tracing.

Dialog Box Options

File Name
Use to select the file(s) you want to trace. Either type the name of the file or select it 
from the list. If you select more than one file, the Batch Files Roll-Up will open.

List Files of Type
Use to select the type of file you want to trace.

Filter Information
Displays information about the filter used to open images of the chosen file format.

Directories
Use to select the directory in which the file you want to open is stored.

Drives
Use to select the drive in which the file you want to open is stored.

Preview
Click this box to automatically have a small bitmap picture of the selected file 
displayed in the view box.

Preview Window
Displays a small bitmap image of the selected file if a check mark has been placed in 
the Preview box.

Image size list
Drop-down list box of options for modifying the size and resolution of an image when 
opening it. You can open the image at its Full Size, Crop it or even Resample it.    Crop 
and Resample are not available when you choose several files for a batch trace. 

Options...
Extends the dialog box to display the Sort By option to specify name or date as the sort
criteria for the currently listed files, as well as file information such as Date, File Size, 
File Format, Width, Height, Color Depth.



Crop Image dialog box
The Crop Image dialog box allows you to crop an image before loading. The cropping is 
permanent and reduces the size of the image.

Dialog Box Options:

Preview Window Displays the entire image with a bounding box. Move the nodes 
on the bounding box to crop the image. Use the Hand cursor to 
move the bounding box to a specific area of the image.

Units Choose the units of measurement.

Max Click to select entire image or to resize the bounding box to 
cover the entire area and reselect the cropped area.

Top Enter a number or use the scroll arrows to position the top of 
the cropped area.

Left Enter a number or use the scroll arrows to position the left side 
of the cropped area.

Width Enter a number or use the scroll arrows to select the width of 
the cropped area.

Height Enter a number or use the scroll arrows to select the height of 
the cropped area.

New Image Size Displays the size of the cropped image.



Resample dialog box
The Resample dialog box resizes an image and creates a new file. The Resample option on 
the Open Bitmap dialog box only resamples to a smaller size.

Dialog Box Options

Units Choose a unit of measurement from the drop-down list box.

Width Enter a number or use the scroll arrows to choose a number or 
enter a percentage in the % box. If a number is entered in the 
first box, the % box reflects the change and vice versa. You can 
enter either a number or percentage but not both.

Height Enter a number or use the scroll arrows to choose a number or 
enter a percentage in the % box. If a number is entered in the 
first box, the % box reflects the change and vice versa. You can 
enter either a number or percentage but not both.

Horizontal Enter a resolution. The maximum is 300 dots per inch.

Vertical Enter a resolution. The maximum is 300 dots per inch.

Identical Values When checked, the Horizontal and Vertical resolutions are 
always equal.

Original Image Size Displays the size of the original image.

New Image Size Displays the size of the resampled version.



Batch Files Roll-Up 
Displays the Batch Files Roll-Up. This roll-up allows you to select several files for tracing and 
control the batch tracing process. Roll-ups contain many of the controls found in dialog 
boxes: command buttons, text boxes, drop-down list boxes and so on. But unlike most dialog
boxes, the roll-up stays open after you apply the selected options. This lets you make 
adjustments and experiment with different options without having to re-open a dialog box.    

Roll-up Options

File names box
A list of the selected files appears in this box.

Add
Open one or more files for tracing. The Open Files dialog box will be displayed. To 
select more than one file, hold the left mouse button down and drag over the names. 
To select files randomly, hold the Shift key down when clicking the file names. 

Delete
Deletes the selected file.

View
Click or double click any file name in the file names box to display a bitmap 
representation of the file.

Info
Click a file name in the file names box and click the Info button for image information 
such as Date, Size, File Format, Width, Height, Color mode, Resolution, and 
Compression.

Trace Selected 
Highlight a single file name in the file names box and click the button to trace the file; 
or hold the Shift key and click several files to select them for tracing.

Trace All 
Click the button to begin tracing all the files in the list. The tracing method and 
parameters must be the same for all files. Files of different bitmap formats may be in 
the same list. Press Escape to stop the tracing process.

Tracing method buttons
Click the appropriate button to choose the Outline, Centerline, Woodcut, OCR, or Form 
tracing method. The Silhouette method is not available in batch mode.

Roll-up Control Menu
Click the control button to manipulate the roll-up.



Save command (File menu)
Displays three options: 

· Trace As..., to save the traced image.
· Text As..., to save the traced text as an ASCII text file.    This option is available 

only when text is traced using
 either the OCR or Form tracing method.
· Image As..., to save the original bitmap image with a new name.

In each case a dialog box is displayed allowing you to save a file with a new name, or 
location.

Dialog Box Options

File Name
Use to type in the file name you want.

Save File as Type
The file format is    .EPS when saving a trace, .BMP    when saving an image, .TXT when 
saving text.

Directories
Use to select the directory in which you want to save the traced file.

Drives
Use to select the drive in which you want to save the traced file.



Acquire Image (File menu) 
Allows you to select a scanning device and scan an image from within CorelTRACE.
Select Source:

Use this command to choose a standard image input driver such as the Corel Image Source. 
The sources that appear in the Select Source dialog box depend on the scanner driver(s) 
installed on your computer.    Once you select a source, you can use the acquire command 
described below to obtain an image for tracing. 
Acquire

Use the Acquire command to control your scanner. The dialog box displayed varies according
to the type of scanner in use. Some scanners will provide more options that are accessed by 
clicking the Settings button.    See Corel Image Source dialog box if it the source you select.



Corel Image Source dialog box
This dialog box is displayed when the Corel Image Source is selected in the Acquire Image 
command. This dialog box may be different if you chose another source in the Select Source 
dialog box.

Dialog Box Options

View Area
Located on the left hand side, it represents the scanner bed.    It includes rulers which 
display the width and height of the View Area. The units of measurement can be 
changed in the Units box. See below.

Scan Area box
Rectangular area with control points at each corner located inside the View Area. Marks
the scanner bed area to be scanned.    If you scanner driver allows you to set a Custom 
paper size, you can drag the square control points to resize the scan area box. The 
Location boxes, described below, are also used to resize the Scan Area box.

Image Information
Immediately below the View Area, it displays the image size and available memory in 
bytes. The image size is estimated on the basis of the size of the Scan Area, the 
chosen scanning resolution and other parameters described below.

Scanner list
On the right hand side, it displays a list of installed scanners for you to select one.

Location selection boxes
The Left and Top boxes display the distance between the rulers and the top left corner
of the Scan Area box.    You can change the location of the Scan Area box by changing 
the values in those boxes.
The Width and Height boxes display the size of the Scan Area box. You can change its
size by using those boxes.

Resolution box
Allows you to set the resolution to be used to scan the image.    The top box is a drop-
down list of available resolutions for the selected scanner.    If your scanner offers a 
"custom" resolution, use the second box to precisely set the desired resolution.
Note that a higher resolution gives a produces a more accurate and detailed image but
requires more time and increases the file size. 

Units box
Lets you select the units of measurement for the rulers.    The current selection appears
at the top left corner of the View Area.

Colors box
Lets you select the maximum number of colors or levels of gray to be used in scanning 
the image when using a color scanner.    The options listed in the box are: 16 million 
colors, 256 levels of gray and black and white.    Note that to use the Prescan button, 



grayscale must be the color setting.

Halftones box
Lets you select a halftone pattern for images if you are working in black and white.    
The options displayed in the list box are scanner specific and are used to control the 
dithering produced by scanning in black and white.

Paper Size box
Lets you select a paper size which is used by the Scan Area. The options displayed in 
the box are scanner specific. If a "custom" option is listed, use the Scan Area box 
control point to set its size.

Settings
Displays the Scanner Setup dialog box which offers scanner specific options.    Controls 
most often listed here include the brightness and sharpness levels to be applied when 
scanning the image.

Progress Meter
Provides a visual progress report while the image is being scanned.

Prescan
Displays the document placed on the scanner bed in the View Area. Prescan uses 
grayscale as the color setting and the scanner's lowest resolution regardless of the 
settings you choose for these options. Use Prescan to precisely size and position the 
Scan Area box.

Scan
Starts the scanning process.



1,2,3 File list
Displays the name of the last files used in CorelTRACE.    Type the number next to the file you
want to open or click on its name.



Edit Image command (Edit menu)
Use this command to call an external paint program. You can then edit the bitmap before 
tracing it. CorelPHOTO-PAINT is the default program.



Outline command (Trace menu)      
Activates the outline tracing method.
This tracing algorithm traces the edge of each element in the bitmap image and fills the 
resulting outline in accordance with the type of image being traced. 
Various options can be specified using the Edit Options command (Trace menu).
For a black and white image, any areas which were black in the original image will also be 
black when printed or viewed in CorelDRAW or a page layout program. For color and gray-
scale images, CorelTRACE uses colors and shades of gray that are the closest match to the 
bitmap image. 
Best for tracing images containing many thick, filled objects, gray-scale and color images, 
and images consisting of white lines on a black background. 
Since each element is treated as a filled area, lines appear as elongated ovals or rectangles 
when viewed in CorelDRAW. A shape such as a circle or the letter "e" which has an outer and
an inner outline is created by filling the outer outline with black, then filling the inner outline 
with white. The resulting objects are then layered with the white object placed on top of the 
black. This arrangement becomes apparent when viewing the object in CorelDRAW. 
The Outline method sometimes produces gaps in very thin curves.    For hints on how to 
resolve this issue see Outline method and gaps.



Centerline command (Trace menu)      
Activates the centerline tracing method.
This tracing algorithm treats thin lines as objects having a certain thickness but no fill. The 
line itself and not its outline is traced. 

This is best for images that contain many thin black lines such as architectural drawings or 
technical illustrations. Centerline combines some of the techniques of Outline tracing 
when objects filled with black are detected. 

Images traced with the Centerline method must consist of black lines on a white 
background. If the image is not black and white, use the Convert to Monochrome option in 
the Image Filtering dialog box to convert the image prior to tracing.

NOTE: The Center Line tracing method tends to distort the ends of sharply tapered objects.
The quickest way to correct this problem is to edit the image with CorelDRAW. You can also 
try retracing the image using the Outline method. Retracing, however, can create gaps in 
curved lines less than one point thick. 

Various line settings options can be specified using the Edit Options command (Trace menu).



Woodcut command (Trace menu)      
Specifies the woodcut special effect that creates a traced image with lines drawn across it at
specified angle. The line shape, width, and angle can be adjusted.
Various woodcut effect options can be specified using the Edit Options command (Trace 
menu).



OCR command (Trace menu)      
Converts text    from the scanned bitmap so that the letters can be manipulated as normal 
text in CorelDRAW. The OCR method will only recognize black text on a white background. 
The Image tab of the Tracing Options dialog box has options to convert a color file to 
monochrome and invert colors in an image.    These options allow you to prepare a color 
image, or an image composed of white text on a black background, for OCR.
For best results with the OCR method, use a high resolution of 300 to 500 dpi when scanning
an image. 
Various options can be specified using the OCR tab of the Edit Options command (Trace 
menu).



Silhouette command (Trace menu)      
Traces the outline of a selected area and creates an object filled with a single silhouette 
color. This color is pre-selected with the Eyedropper tool or the Magic Wand. Click the 
small triangle on the Tracing Color Box to access the Color Palette.



Form command (Trace menu)      
This command activates the Form tracing method. The Form tracing method is in a way, a 
hybrid of the OCR, Centerline and Outline methods. It traces text, then lines, and then any 
remaining objects from a scanned form.    The Tracing Options found in the OCR and Lines 
tabs affect the results produced by the Form method.
The Form tracing method only recognizes black on a white background.    
Sometimes, graphical objects may be recognized as alphabetic characters. To retain the 
object as a graphic, select it as a partial area with the Pick Tool and perform an outline trace.
Save this trace and combine it within CorelDRAW with the remainder of the traced form.
If you are working with a scanned form that has color on it you can use the Image Filtering 
tab to convert the scanned form to monochrome before using the Form method. An 
alternative to this is to combine tracing methods.    The Outline method can be used to trace 
the color objects of the image, selected with the    Magic Wand or Pick tool.    Then, select the
black objects and use the Form method to trace them.      



Edit Options (Trace menu)
Displays the Tracing Options dialog box which includes a tab for each of the five options 
categories and a general Setting group for saving your settings files.
Tracing options control the amount of detail reproduced by the tracing process.    High 
tracing accuracy produces a larger traced file size.    Changing the options will affect the size 
and complexity of the traced file.    Keep in mind that if a file becomes too complex, you 
could have problems importing it into CorelDRAW or printing it.

Dialog Box Options

Category Tabs
Each tab includes tracing parameters that you can set to ensure the tracing results. Click the
category name to see detailed information about the available options.

Setting
The Setting group is where you write a description for the combination of options you choose
and assign it a filename.    Save stores the settings using the displayed filename, assigns the
.CTR extension to the file and closes the dialog box.    The settings filename appears in the 
Settings drop-down list box in the ribbon bar. There are four ready-made settings files 
included with CorelTRACE and displayed in the Settings drop-down list. They are:
Mono Default settings for monochrome (i.e. black & white) tracing.
Color Default settings for color tracing.
Form Default settings for the form tracing method.
Dithered Default settings for tracing an image that has dithered colors. 
NOTE:    The four .CTR files provided with CorelTRACE can be modified. They are general 
settings covering a broad range of tracing situations which, in most instances, provide 
satisfactory results.    We therefore recommend that you keep them as they are and save 
your new settings with different file names.



Image settings (Trace menu)
Displays the Image settings tab for specifying various parameters affecting how the source 
image will be traced. 

Dialog Box Options

Smooth Dithering
CorelTRACE smoothes dithered pixels to improve the traced image.

Invert Colors
This specifies a numeric inversion of the RGB values of the various colors in the image. 
For example, the RGB values for white would be 255, 255, 255. The inverted values 
would be 0, 0, 0 or black. To determine the inverted value for a color, subtract the 
value from 255.    

Convert to Monochrome
Control the conversion of an image to black and white by specifying various RGB 
values. Experiment to achieve the level of detail that you want in the final 
monochrome traced image. 

Threshold...
Use the slide control to set the threshold. If set to low, only very dark colors will be 
black. If set to high, only very bright colors will be white. Use the boxes to enter 
individual values for Red, Green, and Blue or click the Default button to specify the 
RGB value of 128. The Convert to Monochrome box must be checked to access 
these options.

Reduce Colors
Check the box to reduce the number of colors. The Reduce Colors box must be 
checked to be able to enter a number in the To... box. For example, for a value like 8, 
CorelTRACE will examine all the colors in the image and select the best eight colors to 
determine the outlines for what will be traced.



Color settings (Trace menu)
Displays the Color settings tab for specifying the color tolerance value. The color tolerance 
adjusts the Magic Wand selection tools and the tracing tolerance used by CorelTRACE to 
distinguish objects.

Dialog Box Options

Selection Wand and Tracing Tolerance
Use the slide control to quickly control color tolerance. A low value indicates that colors
must be very close to match. A high tolerance means that many colors will fall within 
the same range.
In CorelTRACE, an equal tolerance value is used to distinguish objects. The default 
tolerance value for the Magic Wand is plus or minus 48. A lower tolerance number 
creates a traced image with more detail. Tracing will take longer with a low tolerance 
number. Color tolerance can be thought of as color similarity. Similar colors within the 
specified range are treated as one color.
Use the slide control to quickly control color tolerance. A low value indicates that colors
must be very close to match. A high tolerance means that many colors will fall within 
the same range.
To specify RGB values, click the RGB button and enter a value in each box.
Click Default to specify    RGB default values of 48.



Line settings (Trace menu)
Displays the Line attributes settings tab for specifying tracing parameters that have an 
effect for the Outline, Centerline and Form tracing methods.

Dialog Box Options

Curve Precision
This option determines how tightly the trace output should follow the curves of the 
original image.

Line Precision
Use the default setting if you want to capture as much detail in the original image as 
possible. CorelTRACE first attempts to convert all edges to simple linear paths (without 
curves). This control dictates how straight a line must be before it is converted to a 
line. 

Target Curve length
This option limits the length of individual curves in the traced image. For most types of 
images, the default setting Very Long is usually adequate. To reproduce as much 
detail in the bitmap image as possible, select Short or Very Short. A shorter Curve 
Length setting produces more nodes, which results in a larger traced image file. 
CorelTRACE creates these nodes during the tracing process and joins them together to 
reproduce the bitmap curve. 

Sample Rate 
For the closest match possible, set Sample Rate to Fine; the tracing process looks at 
every pixel.    It is slower but true to the image. If the rate is Coarse, consecutive 
points are averaged. This eliminates points and jaggies along a line. Use the Medium 
default settings for most images. 

Minimum Object Size
CorelTRACE counts the number of pixels in the object outline. Increase the number to 
filter out small objects. A low number will increase the amount of detail in the traced 
image.

Outline Filtering
This option determines the smoothness of outlined objects in the traced image.    To 
smooth out the jagged outlines of the original image, set to Smooth Points or 
Medium. If fine lines in the traced image appear broken or don't show up at all, set 
Outline Filtering to None.
The effect of this option is more noticeable when tracing images scanned at 150 dpi or 
less.

Max Line Width
This defines the widest object that will be taken as a centerline by CorelTRACE.
Use the Outline tracing method if the majority of lines are wider than 20 pixels at 300 
dpi. If the ends of lines in a traced image look distorted, reduce Max Line Width, then
retrace. If curves in the traced image have gaps, increase Max Line Width and 
retrace. To trace all lines in the image as lines rather than filled objects, set Max Line 



Width to match the weight (in pixels) of the heaviest line. 

Create Lines of Uniform Width
Check this box to assign a specific weight from 1 to 50 pixels to all lines in the image. 
The default is 4 pixels. 

Horz and Vert Line Recognition 
Click the box to have CorelTRACE rotate the entire page if the lines are not perfectly 
vertical or horizontal.



Woodcut settings (Trace menu)
Displays the Woodcut settings tab for specifying woodcut special effects described below. 
The settings chosen here are only valid when the Woodcut tracing method is selected.

Dialog Box Options

Continuous Cut
If selected, the cut will be made without breaks (from left to right). Otherwise, the cut 
fades out in bright areas.

Tapered Ends 
This option allows you to specify a gradual narrowing effect for the end of each line.

Sample Width 
Specifies the width of each line in pixels. The lower the number, the greater the 
number of lines.

Angle of Cut 
Determines the angle of the lines. A negative number for the angle of cut creates a 
mirror image of the positive angle. 

Default
Click Default to specify default values for all the woodcut options. The defaults are no 
continuous cut, no tapered ends, sample width of 20 pixels, and an angle of cut of 30 
degrees.



OCR settings (Trace menu)
Displays the OCR settings tab. The settings chosen here are valid only for the OCR and Form 
tracing methods.

Dialog Box Options

Check Spelling Place a check mark in the box to enable the spell checker during the 
tracing process. Incorrectly spelled words are not traced.

Language Drop-down list of language dictionary files.    Select the appropriate 
language to ensure the OCR properly traces the accents and other 
special symbols in the language of the document. Choosing the 
language also enables the spell check function for those languages.
If you do not use the correct dictionary to trace a document in another
language, the characters are recognized but accents and special 
symbols are not traced.
French, German, Spanish or Swedish dictionaries are available on the 
CorelDRAW CD-ROM included in the box.    You may also obtain them 
from the Corel Technical Support bulletin board. See the Reference 
section of the Online Help for Corel phone numbers.

Image Source Indicate the origin of the source document by clicking the appropriate 
name in the drop-down list box. CorelTRACE produces better 
recognition results based on the nature of the source.

Normal Select for documents with standard fonts with a resolution
of 300 dpi.
Preferred method for printed materials and laser printer 
output.

Dot Matrix Select if the source image is a scanned from dot matrix 
printout.    The OCR process is slower than it would be for a
normal source for the document as a dot matrix output is 
of lesser quality and more demanding on CorelTRACE's 
OCR capabilities.

Fax Fine Select if the source image is a standard scanned fax.    
Usually, the resolution for such a document is 100 by 200 
dpi.

Default Assigns the default settings for OCR which specify no spell check and 
a Normal image source.



Save options command (File menu)
Displays the Save Options dialog box for specifying where to store your traced images stored
and how to handle file name conflicts. 

Dialog Box Options

Select a default output directory
Used to specify a directory (called) the Output Path or destination directory where 
traced images will be saved. To change the current Output Path, click the Drives box 
and select the desired drive letter. 

Always Prompt (on Name Conflict)
Check the box to be alerted when a file with the same name already exists in the 
destination directory. This is the default option. When a filename conflict occurs, a 
dialog box appears. To write over the existing file, click Yes. To give the file a different 
name, click No. A dialog box prompting you to enter a new name will appear. Click 
Cancel to return to the Main dialog box.

Always Replace (on Name Conflict)
Check the box to write over the existing file without any warning prompts.

Make File Read Only
Check the box to make the saved file a read-only file.

Save text as *.TXT
Check the box to add (.txt) as the file extension. This option is active only for the OCR 
tracing method.



Save Trace (File menu)      
This command automatically saves the traced file in the PostScript (.EPS) format. The saved 
trace is located in the same directory and has the same filename as the original bitmap file.



Exit (File menu)
This command ends the current CorelTRACE session. Use the mouse to click on the Exit 
button, or from the keyboard, type the letter X.
If you choose this command and have an image and/or traced image that has not been 
saved, a box appears prompting you to save the file(s).



Undo (Edit menu)
This command allows you to undo the last tracing commands one at a time. This is useful 
when you are building up a traced image with the Magic Wand and the silhouette tracing 
method. The tracing procedure does not need to be repeated from the beginning.



Cut (Edit menu)      
This command allows you to cut the trace output to the clipboard as a WMF file for use in 
other applications.



Copy (Edit menu)      
This command allows you to copy a traced image to the Clipboard.    The traced    image 
remains displayed in    the CorelTRACE screen.



Paste (Edit menu)      
This command allows you to paste a copy of a Device Dependent Bitmap (DIB) from the 
Clipboard for tracing.
The most common DIB files are BMP files also called Windows Bitmaps.    Most images cut or 
copied from paint programs such as CorelPHOTO-PAINT are DIB files.    Certain paint 
programs prompt to choose the type of bitmap you want to cut or copy to the Clipboard; in 
that case, DIB if usually one of the options.    



Clear (Edit menu) 
This command allows you to clear the traced image from the tracing window.



Image Info... (View menu)      
Displays the Image Info dialog box.    The top section of this box shows a summary of source 
image information. Name, date, file format, file size, width, height, and color depth are 
displayed.    The bottom section shows information about the traced image, namely the 
object count and the node count for the traced image.



Refresh Window (View menu)
Redraws the current trace output and the source image. This is useful to remove "dirt" left 
on the screen during earlier manipulations.



Clear Marquee (View menu)
Erases the current selection marquee. The entire image will be examined if the image is 
traced again.



Contents (Help menu)
Displays the CorelTRACE Help screen. From this screen, you can choose the type of Help you 
want. When you are in Help, clicking on the Contents button takes you back to the opening 
screen.



Screen/Menu Help (Help menu)      
Changes the mouse pointer to an arrow with a question mark. You can then click on an 
available menu command or a part of the screen to get Help about that item. 
NOTE: To get Help on unavailable (gray) commands, select the command and press F1.

Shortcut

Pressing SHIFT+F1 displays the Help pointer.



Search for Help On (Help menu)
Displays the Search dialog box where you enter keywords to search for a specific Help topic. 
The Search dialog box can also be opened by choosing the Search button from the Help 
window.



About CorelTRACE! (Help menu)
Displays a dialog box with information about which version of CorelTRACE you are running.
The System Info button opens the System Info dialog box.



System Info dialog box
Use System Info to display information about your system, display, network, printing, Corel 
EXEs & dlls and system DLLs.

Dialog Box Options

Choose a category Choose a category from the drop-down list box. The categories are: 
System, Display, network, printing, Corel EXEs and DLLs and 
system DLLs.

List box Displays the system information for the chosen category.

System: information about your computer. For example, Windows 
version, DOS version, processor, etcetera.

Display: information about your monitor. For example, driver, driver
version, etcetera.

Network: information about the network. For example, drivers, 
whether a network is installed, etcetera.

Printing: information about installed printers.

Corel EXEs and DLLs: lists all of the Corel EXEs and DLLs.

System DLLs: lists all of the system DLLs.

Save Saves all of the selected category's details to a predefined file.



Pick Tool 
The Pick tool is used to define a rectangular area to be traced.



Magic Wand (Plus)
The Magic Wand tool (plus) is used to select a color range within an on screen image.    The 
color range is specified in the Tracing Options dialog box.
You can select several areas to be traced at once by pressing the Shift key as you click the 
source image with the Magic Wand tool.



Magic Wand (Minus)
The Magic Wand tool (minus) is used to deselect an area that has been selected with the 
Magic Wand (Plus) tool. The color range is specified in the Color settings tab of the Tracing 
Options    dialog box.



Zoom in tool
The Zoom in tool is used to magnify a selected area of the source image.



Zoom out tool
The Zoom out tool is used to zoom away from a selected area.



Eyedropper
 The eyedropper is used to pick up a color from the source image. This color becomes the 
tracing color and is displayed in the Tracing Color box.



Tracing Color Box

Tracing Color box indicating the selected tracing color. This option is available for the 
Silhouette and Woodcut tracing methods only. The box gives access to the Select Color 
dialog box.



 Select Color dialog box
The Select Color dialog box is used to select a tracing color for a silhouette or a woodcut. 
Click the Tracing Color box to display the current palette. Click the More button at the 
bottom of the palette to access the Select Color dialog box.

Dialog Options

Show Selects the color model. The options are: CMYK, RGB, HSB, Grayscale, 
Standard Colors, FOCOLTONE, PANTONE Spot colors, PANTONE Process 
colors, TRUMATCH, Custom Palette.

Preview The color model selected determines the display of the colors in the 
Preview box.
CMYK Shows CMYK model and list boxes for each of the 

components.
RGB Shows RGB model and list boxes for each of the 

components.
HSB Shows HSB model and list boxes for each of the 

components.
Grayscale Shows grayscale model and Gray Level list box.
Standard Colors Shows Standard Colors model.
FOCOLTONE Shows FOCOLTONE model, Show Color Names 

checkbox and a Search for: box.
PANTONE Spot Shows spot colors, Show Color Names 

checkbox, Tint and Search for: boxes.
PANTONE Process Shows process colors, Show Color Names 

checkbox, Tint and Search for: boxes.
TRUMATCH Shows TRUMATCH colors, Show Color Names 

checkbox, Tint and Search for: boxes.
Current/New color Displays the current color in the top half and the new selected color in 

the bottom half. 

New Field used for the entry of a new color name.

Custom Palettes Arrow button displays commands that Add Color, Delete Color, 
create a New palette, Open an existing palette, Save a palette, Save 
As a new palette, Set As default the current palette. The Preview 
box displays the colors in the selected custom palette.

Mixing Area Used to choose colors from existing bitmaps, from the Show Preview 
box, from the Custom Palette Preview box or any combination of the 
three.    Arrow button displays commands that Load bitmaps as the 
paint area, Save a paint area and Clear a paint area. The Paintbrush 
button paints the selected color on the Paint Area and can mix that 
color with colors already in the paint area. The Eyedropper button 
selects a color from the paint area; it is displayed in the Current/New 
preview box.



VERSION 4 TOPIC;    NO LONGER DISPLAYS, REPLACED BY TOPIC 
ABOVE:    KEEPING IT AS SOME INFORMATION MAY STILL BE USEFUL 
AND COULD BE INSERTED IN OTHER TOPICS OR ADDED AS JUMPS AT 
THE BOTTOM OF THE TOPIC ABOVE.

Select Color dialog box
The Select Color dialog box is used to select a tracing color for a silhouette or a woodcut. 
Click the Tracing Color box to display the current palette. Click the More button at the 
bottom of the palette to access the Select Color dialog box.

· If you are using a color monitor, remember that the colors you see will not match the 
printed colors exactly. To accurately specify Process colors, use the CorelDRAW Process
Color Chart or a TRUMATCH Color Reference if you are choosing colors from the 
TRUMATCH palette. To specify Spot colors, use the PANTONE Color Reference.

· Colors previewed on monochrome monitors and printed on black and white printers will
appear as appropriate shades of gray.

Dialog Box Options

Show
Displays various Color Models such as CMYK, RGB, HSB, PANTONE Spot, or Trumatch.
Process Color
Defines color by combining percentages of Cyan, Magenta, Yellow and Black. Use this 
method if your graphic contains several different colors which you plan to reproduce on
an offset printing press. Process color can also be used when printing directly to a color
printer or film recorder.
CMYK, RGB, HSB
Allows you to create custom process colors using one of three Process color models.
You can create colors by specifying percentages in the text boxes or by dragging color-
adjustment markers in the visual selector.
CorelTRACE automatically performs Gray Component Replacement when you create a 
color with the CMYK visual selector.
If you print color separations, colors specified with the HSB    and RGB models will be 
converted to their CMYK equivalents.
After you create a color, CorelTRACE applies it to the selected object but does not add
it to the palette unless you type a name in the Color Name box and choose Add 
Color from the Palette> menu. 
Spot Color
Defines color using the PANTONE Matching System (PMS). Spot color is appropriate for 
creating graphics that contain only a few colors that you intend to separate on paper 
or film. You can also use it when printing directly to a color printer or film recorder. 
Custom Palette
Allows you to select an existing color. Holding the mouse button down on a color and 
dragging lets you move the color to another spot in the palette. When you return to 
your tracing, the current palette will also show the color in it's new position.
The % tint control beside the Spot color palette adjusts the density of the selected 



Spot color. 
Show Color Names
Click the box to select colors by name.

Search String
Lets you find a particular color by typing some part of its name. As you type, the list 
box scrolls automatically to the color that most closely matches what you type. For 
example, if you type "or" the color "PANTONE Orange 021 CV" will be highlighted. 
(Note: you do not need to type the word "PANTONE".)

Current Color Box
Displays the selected object's current color at the top and the new color you select or 
create at the bottom.

Color Name
Displays the selected color's name. When you create a color, type a name for it in this 
box. If you want to edit an existing color's name, select the color from the palette, then
choose Show Color Names.

Custom Palette >
Displays a menu with commands for managing the palettes.
Add Color
Adds a color you create to the end of the palette.
Delete Color
Deletes the selected color from the palette after prompting you to verify your choice. 
New
Allows you to select a new palette as the custom palette.
Open
Displays the Open dialog box where you can select different color palettes to load into 
CorelTRACE.
Save 
Saves the palette under the name displayed under Custom Palette. Use this 
command to save a palette that you have modified by adding, deleting or rearranging 
colors.
Save As
Displays the Save dialog box where you can assign a new name to the current palette.
Set As Default 
Loads the current palette each time you start CorelTRACE.



Help button    
Click this button to get the help cursor which opens help on the screen or menu item you 
click with it.. 



File open button 
This button displays the Open Files dialog box for selecting a bitmap file(s) for tracing.    See 
the Open command for details on the dialog box options.



Save trace button 
Click this button to save the traced image.    CorelTRACE automatically assigns the traced 
image the .EPS file format and saves it using the same filename and in the directory as the 
original bitmap image.



Cut button 
Click this button to copy a traced image to the Windows Clipboard and clear the trace area.   
The trace output is sent to the clipboard as a WMF file for use in other applications.



Copy button 
Click this button to copy a traced image to the Clipboard.    The traced image remains 
displayed in    the CorelTRACE screen.



Paste button  
Click this button to paste a Windows Bitmap in as the source image in CorelTRACE.



Drop-down settings list 
Lists the files that contain the tracing options and parameters selected.    You can edit 
existing Settings files or create new ones using the Edit Options command. Click the arrow 
on the right-hand side to see the drop-down list of all settings files available and select one 
for a particular tracing task.



Batch Files Roll-Up button 
Displays the batch files roll-up window in which you list all files to be traced consecutively.    
See Batch File Roll-Up.



Mosaic Roll-Up button 
Displays the CorelMOSAIC file management application as a roll-up window in CorelTRACE.    
The Mosaic roll-up allows you to bring images into CorelTRACE by using drag and drop. See 
Mosaic Roll-Up for additional details.



Outline trace button 
Use this button to activate the Outline tracing method.    See Outline command for additional
information.



Centerline trace button 
Use this button to activate the Centerline tracing method.    See Centerline command for 
additional information.



OCR button 
Use this button to activate the OCR (Optical Character Recognition) tracing method.    See 
OCR command for additional information.



Form trace button 
Use this button to activate the Form tracing method.    See Form command for additional 
information.



Woodcut trace button 
Use this button to activate the Woodcut tracing method.    See Woodcut command for 
additional information.



Silhouette trace button 
Use this button to activate the Silhouette tracing method.    See Silhouette command for 
additional information.



Image Info button    
Displays information about the image and the trace if one is displayed on screen.    This 
button performs the same function as the Image Info command in the View menu.



Scanning images
A scanner is a device that converts images on a page or transparency into digital form. 

To acquire an image from CorelTRACE:

1. Choose Acquire Image in the File menu. A flyout menu appears.

2. Click Select Source and choose the appropriate image source in the list that appears.    The Corel
Image Source is provided; other sources can be listed here if some were provided with your 
scanner or scanning software packages. The remaining steps of this procedure are based on the 
Corel Image Source.    Options for other sources may be different.    

3. Choose Acquired Image again.    In the flyout menu, choose Acquire. The Corel Image Source 
dialog box appears.

4. Click the Prescan button to perform a preliminary scan of the entire image.    The image appears 
in the View Area which represents the scanner bed.

5. Select an area by dragging on the corner handles of the Scan Area marquee. 

6. Click the Scan button to perform a final scan. 

See also Tips on scanning images.



Preparing images for tracing
You may need to modify a scanned image before tracing it with CorelTRACE.    Any bitmap 
editor, such as CorelPHOTO-PAINT, can be used to prepare, correct or enhance your scanned
images.

Editing and enhancing scanned images using a bitmap editor

· Correct straight lines that appear broken or jagged due to poor alignment before 
tracing. 

· For black and white artwork, adjust contrast or intensity controls for the sharpest 
image possible. For fine lines (less than 1 point) that don't appear in the bitmap image,
increase the contrast or intensity. 

· Adjust contrast and intensity settings for color or gray-scale images. If the image is too 
dark, CorelTRACE cannot distinguish the shades of color or gray. 

Other considerations

· Tracing at 256 levels of gray rather than 16 takes twice the disk space. 

· CorelTRACE sees only 256 colors. If maintaining the shape of the image through the 
tracing process is your priority, as opposed to the image's colors, scan for fewer colors 
(8 or 16). 



Tracing part of an image
The Pick Tool is used to define one or more rectangular-shaped areas of a bitmap for tracing.

To trace a portion of an image:

1. Click the Pick Tool.

2. Define an area(s) of the bitmap image by clicking and dragging the Pick Tool. A selection 
marquee appears around the defined area.

3. Press and hold the Shift key to define additional areas to be selected at the same time.

4. Click on the appropriate trace button to begin the tracing process. 

If you are tracing multiple images, the partial selection is not available. Trace examines 
the entire bitmap.



Tracing part of an image with the Magic wand
The Magic Wand (+) can be used to define one or more specific areas of a bitmap for 
tracing.

To trace a portion of an image:

1. Click the Magic Wand (+) tool.

2. Click an area of the bitmap image. A marquee appears around the area that is within the color 
tolerance range.

3. Press and hold the Shift key and click other areas you want to trace.

4. If needed, click an area with the Magic Wand (-) tool to deselect it.

5. Click the trace button of your choice. If you decide on the woodcut or silhouette tracing methods, 
you can select the tracing color by clicking the Tracing Color button before clicking the trace 
button.



Tracing multiple images
CorelTRACE allows you to trace several images consecutively. The Batch Files Roll-Up is used
to control this task. You must use the same Output Options and Tracing Options for all 
images and the same Color scheme.

NOTE: You can have TIFF, PCX , TGA, JPEG, GIF, Photo CD and BMP files in the list at the 
same time. 

To trace multiple images:

1. Choose Open in the File menu 

2. Drag the mouse cursor to highlight several consecutive file names in a directory and click OK.    
Hold the CTRL key as you click the filenames to select non consecutive filenames.    The Batch 
Files Roll-Up appears and lists all selected files.    The first image on the list is displayed in the 
image area. 

3. To display another image, click its filename in the list and click View.    To see information about an
image in the list, click its filename and click the Info button in the Batch Files Roll-Up.

4. To begin the tracing process, do one of the following:

·      Click Trace All to trace all files listed 

·      Hold the CTRL key and choose files in the list; click Trace Selected to trace only 
the selected files.

A prompt may appear before an image is traced warning that a file with the same name already 
exists in the destination directory. If you want CorelTRACE to trace all images without 
interruption, disable the prompt via the Output Options dialog box.



Adding files for batch tracing
You may want to add files for batch tracing to a single image you have opened, or to ones 
listed in the Batch Files Roll-Up.

To add files for batch tracing:

1. If you only have a single file opened, click the Batch Files Roll-Up button.    It is already displayed 
if you have more than one image selected for tracing.

2. Click the Add button in the Batch Files Roll-Up window.    

3. In the Open Files dialog box, do one of the following:

·      drag the mouse cursor over several consecutive files 

·        hold the CTRL key and click non consecutive files.    

4. Click OK.    The selected files appear in the Batch Files Roll-Up.



Removing a file from the Batch Files list.
1. In the Batch Files Roll-Up, click the filename to remove from the batch tracing job.

2. Click the Delete button.    The filename is removed from the list.



Creating custom tracing settings
You may want to change the default settings for various tracing methods and save them. 
The settings include, among others, options to control the color tolerance, woodcut width 
and angles and how lines are traced. 

To create a custom tracing method:

1. Select the Edit Options command from the Trace menu. 

2. In the Tracing Options dialog box, click a tab name to see and change various parameters. For 
detailed information about each tab, see Edit Options command (Trace menu).

3. Make the changes to the parameters in the various tabs.

4. Type a filename in the Setting section at the bottom of the Tracing Options dialog box. Type a 
description in the Description text box.

5. Click the Add button to save the settings under the filename typed in step 4. Click OK.    The new 
settings filename appears in the Settings list box in the horizontal button bar. 



Selecting custom tracing settings
You can use previously saved custom settings for tracing.

To see a description of the settings before selecting a custom settings file:

1. Choose Edit Options from the Trace menu

2. In the Tracing Options dialog box, click a settings filename in the list box at the bottom of the 
dialog box. The description of the file, if one exists, appears in the description text box and the 
relevant options are displayed in each tab (i.e. Image, Color, Lines, Woodcut and OCR tabs.)

To select previously saved custom settings:

1. Click the arrow on the right of the Settings list box in the horizontal button bar.

2. In the Settings drop-down list, click a filename to select the custom settings.    



Editing an image in Corel PHOTO-PAINT
You may want to edit a source image before tracing it. You can run CorelPHOTO-PAINT from 
within CorelTRACE by using the Edit Image command from the Edit menu.

To edit a source image:

1. Open a file in CorelTRACE and choose Edit Image from the Edit menu. 

2. Use the CorelPHOTO-PAINT tools to edit the image.

3. Click the Update CorelTRACE command in the File menu. 

4. Choose Exit & Return to CorelTRACE from the File menu.

The edited image is displayed in CorelTRACE.



Changing the default paint program
You may want to edit a source image before tracing it. You can run bitmap editors, or paint 
programs, from within CorelTRACE.    The default paint program is CorelPHOTO-PAINT.    You 
can change that default setting to use another program.

To change the default paint program to another program:

1. Select RUN from the Windows Program Manager File menu.

2. Type in Regedit / V in the Command Line

3. Press Return.

4. Select Find Key from the Search menu.

5. Type in .BMP in the Find What box and press Return.

6. Type in the name of the application you want in the value box.

7. Save changes and Exit.



Importing traced files into CorelDRAW
Once traced, you can import the image into CorelDRAW for editing.

You may find that other programs will accept CorelTRACE files, provided they are brought 
into CorelDRAW first, then exported in a format that the particular program supports. 

NOTE: EPS files created by CorelTRACE do not include an image header. You can add a 
header to the image file by importing it into CorelDRAW. In CorelDRAW, you export the file as
a PostScript file with image header included.

To import traced images into CorelDRAW:

1. From CorelDRAW, choose Import in the File menu and click on CorelTRACE as the import type. 

Once the image has been imported, you may work with it in the same way as you would with any 
image originally created with CorelDRAW. 

2. The image is imported as a group of objects. To work on individual elements, choose Ungroup in 
the Arrange menu. 

All of the powerful features of CorelDRAW can then be used to alter the image, including 
changing the shape, fill, outline, position and size of any element. 



Choosing a tracing color
The Tracing Color Box is used to select a tracing color for a silhouette or a woodcut.

To choose a tracing color:

1.    Click the Tracing Color box to display the current palette.

2.    Do one of the following:

· Click a color in the palette 
· Click the More button at the bottom of the palette to access the Select Color dialog 

box to make your color selection.    See Select Color dialog box 
The selected color appears in the Tracing Color Box.

NOTE: The Eyedropper tool can also be used to choose a color from the screen image, see 
Choosing a color from the screen image. Pressing ESC stops any selected action without 
changing the color.    



Choosing a color from the screen image
This procedure allows you to select a color from an on-screen image.

To choose a color from the screen image:

1. Click the Eyedropper tool

2. Click a color in the displayed image. It becomes the selected color and appears in the Tracing 
Color Box.



Creating colors and managing color palettes
CorelTRACE has a number of color palettes. Each contains a particular set of colors. One of 
these palettes contains spot colors defined using the PANTONE Matching System--a color 
specification method used when exact colors are required. You can choose from over 700 
spot colors and create many more by adjusting the tint.

The other palettes supplied with the program contain colors defined using the process color 
method. This method of specifying color is based on the principle that virtually any color can
be represented by overlaying cyan, magenta yellow, and black. The default process color 
palette contains about 100 named colors. For creating your own process colors, CorelTRACE 
offers a choice of three color models: CMYK, RGB and HSB.

The TRUMATCH palette lets you specify process colors using the TRUMATCH Swatching System.
By using this palette along with a TRUMATCH color reference book, you can be reasonably 
certain how the colors will look when printed.

You have the option of assigning names to the colors you create and adding them to the 
palette. You can also delete colors and rearrange their order in the palette. And when you're 
finished, you can save the palette under a new name and have CorelTRACE load it 
automatically when you start the program.



Creating a custom process color
You can create your own Process colors and use them to fill and outline objects. 

To create a custom Process color:

1. Click the Tracing Color Box. This displays the current palette. 

2. Click the More button.

3. From the Show box, choose the model--CMYK, RGB, or HSB--you want to use to create the 
color. See Color Models.

4. Define the color by entering exact percentages in the numeric entry boxes or use the color-
adjustment markers in Visual Selector boxes.

5. To add the color to the palette:

· Type a name in the Color Name box.
· Click the Custom Palette button, and then choose Add Color.

NOTE: You can save the revised palette under a new name by choosing the Custom Palette
button and then Save As.



Adding a tint of spot color to the palette
Instead of adjusting the tint control every time you want to re-use a particular tint of Spot 
color, you can just add the tint to the palette.

To add a tint of Spot color to the palette:

1. Click the Tracing Color Box. This displays the current palette. 

2. Click the More button.

3. If it is not already selected, choose PANTONE Spot colors.

4. Click on the color whose tint you want to change.

5. Adjust the %tint setting to get the desired tint.

6. Click the Custom Palette button, and then choose Add Color. The tint is added next to the color 
you clicked on.

NOTE: You can save the revised palette under a new name by choosing the Custom Palette
button and then Save As. See Opening and saving a color palette.



Saving a color palette
You may want to add colors to existing palettes or rename existing palettes which you 
modified.

To save a new or modified color palette:

1. Click the Custom Palette button.

2. Do one of the following:

· To replace the current palette, choose Save.
· To save the palette under a new name or in another drive or directory, choose Save 
As.
In the File Name box, type or select a new name. To save the palette in another 
drive or directory, select the drive from the Drives box, and the directory from the 
Directories box.



Deleting a color from a palette
You can customize any of the palettes supplied with CorelTRACE by deleting colors.

To delete a color from a palette:

1. Click the Tracing Color Box. This displays the current palette. 

2. Click the More button.

3. From the Custom palette Box click the color you want to delete.

4. Click the Custom Palette button, and then choose Delete Color.



Rearranging the order of colors in a palette
If you use some colors more often than others, you can make them easier to find by moving 
them to the beginning of the palette.

To rearrange the order of colors in a palette:

1. Click the Tracing Color Box. This displays the current palette. 

2. Click the More button.

3. Hold the mouse button down on the color you want to move, and drag. As you begin dragging, a 
black dot appears.

4. Release the mouse button when the black dot is over the square you want the color moved to. 
The other colors shift to the left.

5. Repeat steps 3 and 4 to move other colors.

NOTE: You can save the revised palette under a new name by choosing the Custom Palette
button and then Save As. See Saving a color palette.



Color models
CorelTRACE provides three different color models for creating process colors: CMYK (cyan, 
magenta, yellow, black), RGB (red, green, blue) or HSB (hue, saturation, brightness).

You can create colors using the model you are most comfortable with. If you are going to 
produce color separations, CorelTRACE will convert any RGB and HSB colors into their CMYK 
equivalents. The conversion will not be exact, however, since the RGB and HSB models 
create color in a fundamentally different way than the CMYK model.

CMYK Model
The CMYK model, as its name suggests, is based on the colors of the inks used in four-color 
printing. By combining percentages of cyan, magenta, yellow and black, you can reproduce 
virtually any color you want.

The advantage of the CMYK model is that you can specify your colors using CMYK color 
reference charts and be reasonably certain of what the colors will look like when printed. No 
such charts exist for specifying colors with the RGB and HSB models.

When you use the Visual Selector to specify colors, CorelTRACE automatically adjusts the 
amount of black through a process called Gray Component Replacement (GCR). If you are 
specifying colors numerically, you must do the gray replacement yourself by entering 
appropriate percentages of black.

If your drawing contains large areas of black, you will want to override the GCR process and 
increase the percentages of cyan, magenta and yellow. Doing this makes the blacks look 
much darker. Ask your printer or service bureau for advice on the exact percentages you 
should use.

RGB Model
The RGB color model uses percentages of red, green and blue to create colors. Each 
component has 100 levels of intensity, ranging from black to the component's full intensity. 
Thus, to produce pure red for example, set Red to 100 and Green and Blue to 0. Similarly, 
set Green to 100 and the others to 0 to produce pure green. To produce a dark but pure 
shade of one of the three, lower its setting while leaving the others at 0.

White is produced by setting all three components to 100. Setting them all to 0 produces 
black. Equal amounts of each produces varying shades of gray.

HSB Model
The HSB model, creates color by varying three parameters: hue, saturation and brightness. 
Hue refers to the quality which makes a particular color different from another. Blue, red, 
and green, for example, are all hues. Saturation refers to the purity or intensity of a color. By
varying the intensity, you can make the color lighter or darker. Brightness refers to the 
percentage of black in a color, where 0 percent is black and 100 percent is white.



Opening a color palette
CorelTRACE supplies several different Process color palettes and a single Spot color palette. 
The Process color palettes have different numbers and ranges of color. With some palettes, 
the difference is in whether the colors display on the screen as dithered or pure. 

If you have a TRUMATCH color reference book, you can use the TRUMATCH palette to specify 
process colors.

You can add, delete and rearrange colors in these palettes and then save them under a new 
name. 

To open a color palette:

1. Click the Tracing Color Box. This displays the current palette. 

2. Click the More button.

3. Choose the Custom Palette button, and then choose Open...

4. In the File Name box, type or select the name of the palette you want to open.

If you saved a palette in another drive or directory select the drive from the Drives 
box and the directory from the Directories box.



Using Optical Character Recognition (OCR)
Converts text from a scanned, or other bitmap into editable ASCII text format. 

NOTE:    The OCR method will only recognize black text on a white background. For better 
results, use a high resolution of 300 to 500 dpi.    The source file must be saved as a black 
and white bitmap in order for the OCR method to be available.

To use OCR:

1. Select the Open command from the File menu

2. Select the bitmap file which includes text by clicking the filename then the OK button. The file is 
displayed on the left half of the screen.

3. Choose Edit Options in the Trace menu. Choose the OCR tab.    Click the Default button to use 
the default OCR settings. Change the options in the tab to create custom OCR settings.

4. Select the OCR (B&W) command from the Trace menu.    CorelTRACE begins to convert the text 
to editable text; the traced file is displayed on the right side of the screen.



Choosing the appropriate tracing method
CorelTRACE offers six tracing methods: outline, centerline, woodcut, silhouette, OCR and 
form.    The choice of a method rests on two factors; the composition of the image you are 
tracing and the results you expect. Is the image made up of mostly lines, filled shapes or a 
combination of both?    Are the lines mostly straight or curved? Are they thick or thin?    Do 
you want as much detail as possible or only the general shape(s) of the bitmap image?

The following describes the functionality of each tracing method and the results to expect 
from them.

Outline method
The outline method traces the outline of each element found in the source image and fills 
the resulting outline in accordance with the colors found in the original. The outline method 
described above traces the outline of thin lines converting them to elongated objects.      The 
purpose of using the outline method is to obtain a traced image that closely resembles the 
original image.    This method works best when the source image has thick objects or areas 
of various colors. See also Outline command.

Centerline method
The centerline method treats thin lines as objects that have a certain thickness but no fill.    
Therefore, the line itself is traced instead of the outline of a line.    This method requires that 
the source image consist of black lines on a white background.    If your image is not black 
and white, use the Convert to Monochrome option in the Image tab of the Tracing Options 
dialog box.    The centerline method is ideal for architectural drawings or technical illustration
that contain thin black lines.

Woodcut method
The woodcut method recreates the shape of the source image and fills it with lines across it 
at specified angle. Woodcut line thickness and angle can be adjusted by using the Woodcut 
style tab of the Tracing Options dialog box.      You can also choose the tracing color.    The 
woodcut method is therefore used to create a special effect within a specific shape.

Silhouette method
This method traces the outline of an image, or the selected area of the image, and fills it 
with a single color of your choice.    The silhouette method is recommended when the 
primary objective is to match the shape of the source image.    In this situation, the 
silhouette method is the fastest and produces a smaller file size than any of the other 
methods.

OCR method
The Optical Character Recognition method converts scanned text into editable text. It only 
works with black text on a white background.    It is the method of choice if your goal is to 
edit the text that is traced.

Form method
As its name indicates, this method is useful for tracing scanned forms that include text, lines
and other graphic objects.    It converts text into editable text like the OCR method but also 
converts non text objects contained in the source bitmap.



Tips on scanning images

Resolution and scanned images

· Use high-quality bitmap images.

· Scan black and white images at the highest optical resolution possible (300 dpi for most 
scanners). 

· Color and gray-scale images should be scanned at 150 dpi for simple images. Use a higher dpi 
resolution to get better results with the OCR method. 

· Scaling detailed images by more than 300 percent may cause a noticeable loss in quality. If 
possible, choose a higher resolution to compensate. 

· If fine lines don't show, set your scanner's resolution to at least twice as fine as the finest line 
detail in the image. If the finest line in your original artwork is 1/150" (about 1/2 a point), then set 
your scanner to 1/300", or in other words, 300 dpi.

· When tracing multiple bitmap images at once, make sure that they were all scanned at the same 
resolution to produce consistent results. 

Image size and positioning 

· The maximum image size is 6000x6000 pixels. Tracing images larger than this can yield 
unpredictable results. 

· Position artwork at right angles to the edges of the scanning bed and mount small artwork on a 
sheet of 8.5x11 inch paper before scanning. 



Saving traced text 
When using the OCR or Form tracing methods, the traced image includes editable text. You 
can save that text in an ASCII (.TXT) format instead of saving it as part of the 
CorelTRACE .EPS file created when saving a trace. Saving it as ASCII text allows you to edit 
the text in any word processor.

To save traced text in an ASCII format:

1. Perform the OCR or Form trace of the original bitmap image which includes text.    If the image is 
in color, the tracing methods are not available.    Choose the Mono setting in the Settings drop-
down list box to convert the image to black and white.

2. Choose Save in the File menu.    

3. From the flyout menu, choose Text As.

4. In the Save Text As dialog box, type a filename and choose the drive and directory where the file 
is to be stored.    The file will automatically be given the .TXT extension.



Aspect ratio
The ratio of the width of an image to its height. 



Bitmap
An image composed of a series of dots (pixels). Scanners and paint programs such as PC 
Paintbrush generate this type of image. By contrast, CorelDRAW creates images using vector
objects, which are shapes stored internally as mathematical equations.



Clipboard
A temporary storage area used to transfer information between Windows applications. In 
CorelSHOW, you can cut or copy an object onto the Clipboard, and then paste it into another
application or presentation file.



Control menu
A menu available in all Windows applications. Used to move, resize, minimize, maximize and
close applications. Pressing the Alt key and spacebar or clicking on icon at the left of title bar
opens the Control menu. 



Control menu box
Icon on the left of a window's title bar which opens the Control menu. 



CorelPHOTO-PAINT
A program supplied with CorelDRAW for creating and editing bitmap images.



Device Independent Bitmap (DIB)
A bitmap, also called raster, image that does not require you to have specific hardware (i.e. 
video controller, monitor) in order for you    to use it.    Windows bitmaps (BMP) are almost 
always device independent or DIBs.    



Directory
Like a drawer in a filing cabinet, a directory is part of a structure used to organize files on a 
disk. Directories have names and can be divided into subdirectories. For example, you could 
create a directory called LOGOS for storing logo designs.



Dithered color
Color simulated by putting dots of another color very close together. Windows uses dithering
to display colors that the graphics adapter is unable to display. See also Pure color.



DPI
A measure of a printer's resolution in dots per inch. Typical desktop laser printers print at 
300 dpi, while image setters are capable of printing at resolutions of 1270 or 2540 dpi. The 
more dots per inch, the smoother the output.



Drive
A device in a computer that spins disks used to store information. Personal computers 
normally have a fixed disk drive labeled C and one or two floppy disk drives labeled A and B.



File previewer
In the Open Files dialog box, a small bitmap representation that lets you see the image of 
the selected file before you open it.



Gray-scale image
An image, typically created by a scanner, in which continuous tones are represented as 
uniform shades of gray. 



Image header
The image header is a bitmap representation of the traced image which allows you to 
correctly size and position it in CorelDRAW and other programs. Without the header, the 
image still prints correctly, but instead of the bitmap, your screen displays an empty box. 



Jaggedness
A stair-step effect that often occurs when a bitmap image is enlarged.



Maximize
To enlarge an application window to full screen size.



Minimize
To reduce an application window to the size of an icon without closing it.



Menu
A list of commands that appears when you choose a name in the menu bar. The menu bar 
appears below the Title bar, which is at the top of the window.



Menu bar 
The bar near the top of the window that contains the names of the program menus.



Monochrome
An image containing a single color, usually black.



Nodes
The points at the ends of line and curve segments in a curve object. Also refers to the small 
hollow squares along the outlines of objects drawn in CorelDRAW with the Rectangle and 
Ellipse tools and those next to characters in a text object.



Paint program
A generic term referring to computer illustration programs which store graphics as bitmaps, 
a collection of dots arranged to represent an image. CorelPHOTO-PAINT and Windows 
Paintbrush are examples of paint programs. They are also known as Bitmap Editors. 
Programs such as CorelDRAW, which store images as a series of lines and curves, are called 
draw programs or vector-based drawing packages. 



Pure color
Any color that individual pixels on a computer screen can assume. On a monochrome 
screen, there are only two pure colors, black and white.    Color screens typically display 8, 
16 or 256 pure colors. See also Dithered color.



Resolution
Scanning resolution is the number of samples per inch -spi- (often referred to as dot per inch
-    dpi) produced by a scanner to represent the scanned image.    A higher resolution 
produces a more accurate replica of the image but also produces a file that is bigger in size.  
Typical scanners offer several resolution settings, 300 dpi being the most common 
resolution. 
Choosing a scanning resolution depends on the type of artwork being scanned, the desired 
quality of the final output and even the type of paper on which the final will be printed.    
There is no benefit in scanning at a very high resolution, 1200 dpi for example,    when the 
final output will be produced on a 300 dpi printer. Scaling a scanned image affects its 
resolution; scaling it down increases the resolution and scaling it up decreases it.    You can 
also use the Resample option in the Open dialog box to increase the resolution of an image.
Resolution also refers to the number of dots per inch (dpi) the printer is capable of printing. 
Typical laser printers have resolutions of 300 dpi, while image setters have resolutions of 
approximately 1200 or 2400 dpi. The more dots per inch, the smoother the output.



Scanner
A device that converts images on a page or transparency into digital form.    



Vector graphics
Also referred to as object-based graphics. Graphics created in programs such as CorelDRAW 
in which shapes are represented as a series of lines and curves. These contrast with bitmap 
graphics which are created pixel by pixel in paint programs and by scanners.



Weight
The thickness of outlines assigned to objects. Sometimes used to refer to different type 
styles (normal, light, bold, etc.). 



CMYK
The four letters represent Cyan, Magenta, Yellow, and Black, the ink colors used in four-color 
process printing. CorelTRACE allows you to specify colors using CMYK values.



Gray component replacement (GCR)
A technique in which equal amounts of Cyan, Magenta and Yellow are removed and replaced
with black ink. This produces better color saturation and contrast as well as saving on ink 
costs. CorelTRACE performs GCR automatically when you create process colors using the 
Visual Selector in the Outline Color and Uniform Color dialog boxes. 



HSB
The initial letters in Hue, Saturation and Brightness are the components in the HSB color 
model.    HSB is one of three color models CorelTRACE provides for creating process colors.



Hue
In the HSB color model, hue is the main attribute in a color that distinguishes it from other 
colors. Blue, green and red, for example, are all hues. See also Saturation and Brightness.



PANTONE
A standard color matching system in which solid (spot) colors are specified using color 
sample books. You can use this system in CorelTRACE to specify colors.



Process color
The primary colors used in four-color process printing: Cyan, Magenta, Yellow and Black. See 
also Four-color process.



RGB
The initial letters in Red, Green and Blue, the component colors in one of three color models 
CorelTRACE provides for creating Process colors.



Saturation
In the HSB color model, the component that determines the purity or intensity of a color. See
also Hue and Brightness.



Spot color
In offset printing, solid colors commonly specified using the PANTONE color matching 
system. Spot color is used whenever exact colors are required. CorelTRACE also uses the 
PANTONE system to specify spot colors.



Tints
Lighter shades of a Spot color created by adjusting the %Tint value in the Select Color dialog
box.



TRUMATCH
A color matching system for specifying process colors. You can use this system in 
CorelTRACE to specify colors.



Brightness
In the HSB color model, the component that determines the amount of black in a color where
0% is black and 100% is white. See also Hue and Saturation.



Four-color process
Reproducing color artwork using four separate sheets of film, which represent the Cyan, 
Magenta, Yellow and Black content of the artwork. 



Tracing buttons

Each trace button activates one of the tracing methods in exactly the same manner as 
choosing a command in the Trace menu would.    The buttons represent, from left to right, 
the Outline, Centerline, OCR, Form, Woodcut and Silhouette tracing methods.    If a tracing 
button is dimmed, the method it represents is not available for the type of image opened. 
See the Trace menu for detailed information regarding the tracing methods.





PCX aspect ratio
Images traced from a PCX file come into CorelDRAW with the same aspect ratio as the 
original bitmap image. They are, however, resized to fit an 8.5x11 inch page. Use 
CorelDRAW's stretching and scaling features to restore the proper dimensions. 



Outline method and gaps
Gaps can occur in curves less than one point thick when an image is traced using the 
Outline method. These gaps show up when the image is printed or previewed in CorelDRAW. 
If you magnify the area where one of these gaps appear, you'll see that the outlines of the 
curve cross or overlap. A gap results because no area exists in which to fill the outline of the 
curve. Eliminate the gaps by pulling the lines apart with the Shape tool in CorelDRAW, or by 
selecting black as an outline color. Assign an outline thickness to increase the thickness of 
the curve.



Reducing conversion times
To trace an image stored on a floppy disk, copy the image file to your hard disk before 
tracing it. Tracing from a floppy disk is usually much slower than from a hard disk. 
Avoid running other Windows applications while using CorelTRACE. These applications 
compete for memory and increase tracing time. With large files, your computer may even 
lock up due to insufficient memory.



HiJaak
HiJaak provides a conversion utility that lets you convert numerous formats into TIFF or PCX. 



Printing traced images
To print CorelTRACE images directly from any program other than CorelDRAW, you must 
have a PostScript printer. Bringing the image into CorelDRAW allows you to print the image 
on a non-PostScript printer such as the HP LaserJet.



Why use CorelTRACE?
CorelTRACE is a fast, flexible program that allows you to convert bitmap images into 
compressed vector format. The program recognizes objects, tables, and lines within a color 
or monochrome bitmap. CorelTRACE can also extract text from a bitmap. Silhouette and 
woodcut tracing methods provide additional avenues to creating original artwork.

If you're involved in desktop publishing, you probably have a digital scanner and a graphics 
program that allows you to edit or create your own bitmap images. The major drawback with
bitmaps is their fixed resolution. This limitation shows up as jaggedness when you enlarge 
the image or print it on a high-resolution output device. 

CorelTRACE solves this and other problems associated with bitmaps by turning them into 
vector-based images. This gives your artwork smooth lines that print at the highest 
resolution of your printer. It also means you can scale and even rotate the image without 
distorting it. And what's more, vector images take up less disk space and print faster than 
bitmaps.    

You can use CorelTRACE to trace almost any type of artwork, from logos and letter forms to 
technical illustrations and even scanned text files. As well, CorelTRACE can faithfully 
reproduce colors and shades of gray contained in the bitmap image. Once in vector form, 
the image can be used in a page layout program or brought into CorelDRAW for minor touch-
ups or complete reworking. Scanned text traced using CorelTRACE's OCR capability can be 
edited in any word processing application.



File formats
CorelTRACE accepts black and white, gray-scale and color images saved in the following 
formats: 
TIFF (.TIF) files can be created at any resolution and can have any number of gray levels 

or colors. Their disadvantage can be their very large size. Though some 
scanners can compress monochrome (i.e., black and white) TIFF images by as 
much 75%, CorelTRACE expands the image file back to its original size before 
tracing it. This is an important consideration since large or complex images 
can take up a lot of disk space during the tracing process. You should have 
disk space available equal to ten times the file size of the image you're 
tracing. 

PCX is the format used by bitmap editors such as CorelPHOTO-PAINT.    Like TIFF, 
PCX can handle monochrome, gray-scale and color images. Some scanners, 
however, are limited to 16 levels of gray when saving in PCX format. 

BMP is the native bitmap format of Windows 3.0 & 3.1 and it supports black & white and 
color, but not gray-scale information. These files can be created by the Windows Paintbrush 
program. (Windows 2.1 BMP files cannot be used.) DIB (Device Independent Bitmaps) and 
RLE (a compressed bitmap format) varieties of Windows bitmaps are also acceptable.
GIF is the bitmap format for CompuServe files.

JPEG is a format used to compress large color files.    The JPEG format allows you 
significantly reduce the file size by coding the color information.    Once the 
image appears in CorelTRACE, uncompressed, it may not be exactly the same 
as the original.    Information is lost according to the degree of compression 
and how many times the image has been compressed. 

TGA is the bitmap format used with specialized video products such as the TARGA 
board.

Photo CD is the (.PCD) bitmap format used with compact disc files. 



Obtaining an image
Images may be obtained from various sources such as:

· Digital scanners. 

· Paint programs    such as PC Paintbrush and CorelPHOTO-PAINT.

· Bitmap clipart. 

· Screen graphics captured with programs such as CCapture and HiJaak. 



What to trace

High resolution (300 dots per inch) black and white line art such as, logos, letter forms, 
technical illustrations, and architectural drawings.

Color images made up of areas of solid color is preferable to continuous tone images such as
a color photo scanned from a magazine. 

Gray-scale images with regions of gray clearly defined. If you can discern a dotted pattern in
the colors or grays, the image is probably not a good candidate for tracing. 

To trace a continuous tone image, the best results will occur when you check the Smooth 
Dithering option in the Image tab of the Tracing Options dialog box.

Text and forms can also be traced, allowing you to manipulate scanned text in a word 
processor or art package.



Tracing an image: the basics
To trace an image:

1. Select the Open command in the File menu.    To see a different directory, locate the 
directory in the Directories box, then double-click. 

2. In the List Files of Type list box, choose the appropriate file format or click All images to
list all image files in the current directory.

3. Select an image file by either clicking the filename then the OK button.    

4. Click the Outline trace button.    A visual progress report on the tracing process appears
in the bottom right corner of the screen. The traced image appears in the tracing 
window.



Opening an image
The first step for tracing an image is to open an image (i.e. bitmap) file.

To open an image:

1. Choose Open in the File menu.
2. In the Open dialog box, select the drive and directory where the image file is located.
3. In the List Files of Type list, choose the appropriate bitmap format to see only the 

files of that format displayed in the file list.    Choose All Files to see all bitmap files.
4. Choose the size of the image from the drop-down list box. You can open the image as: 

Full Image, Crop or Resample.
Full Image loads the entire image.    

Crop loads a cropped image. The Crop Image dialog box opens. Crop an 
area.

Resample loads a resampled version of the image. The Resample dialog box 
opens. Resample an area.



Opening a cropped image
You cut part of an image using the Crop option on the Open dialog box. A new image is 
created with the cropped area.

To open a partial area:

1. Choose Open from the File menu.
2. Choose the file.
3. Choose Crop. The Crop Image dialog box opens with the image displayed in the 

Preview window.
4. Click and drag the nodes on the bounding box that surrounds the image in the 

Preview window to crop the image.
Note: Click Max to return the bounding box to its original size.



Opening a resampled image
You resample an image using the Resample option on the Open dialog box. Resample resizes
the image to a smaller size and creates a new file with the resampled image.

To open a partial area:

1. Choose Open from the File menu.
2. Choose the file.
3. Choose Resample. The Resample dialog box opens.
4. Choose a unit of measurement from the Units drop-down list box.
5. Enter a number in the Width box or enter a percentage in the % box. If you enter a 

number in the Width box, the % box reflects the change and vice versa.
6. Enter a number in the Height box or enter a percentage in the % box. If you enter a 

number in the  Height box, the % box reflects the change and vice versa.
7. Enter a resolution in the    Horizontal and Vertical boxes. Resolution is measured in 

dots per inch (dpi).
8. Check the Identical Values checkbox to make the Horizontal and Vertical 

resolutions always equal. 



Stopping the tracing process
To stop the tracing process:

· Press the ESC key. 
To resume tracing of a single file:

· Click the tracing button of your choice. Tracing starts again from the beginning, not the
current position.

To resume tracing of multiple images:

1. Select Trace All from the Batch Files Roll-Up.

2. Tracing will start again from the beginning, not the current position. 



Saving a Traced File
To save a traced file:

1. Select the Save Trace command from    the File menu.    CorelTRACE saves your file 
with the same filename as the original bitmap file but with the file extension EPS; it is 
located in the same directory as the original file.

To save a traced file under a different name, or in different location:

1. Select the Save command from the File menu.
2. From the flyout menu,    select the Trace As command.
3. In the Save Trace dialog box, type a filename and select the directory in which you wish

to save the traced file.



Saving a bitmap image
If you acquire bitmap images from a scanner, you may want to save those images, in a 
bitmap format, as well as the converted images.

To save a bitmap file:

1. Select the Save command from the File menu.
2. From the flyout menu, select the Image As command.
3. From the Save Image dialog box, type a filename and select the appropriate directory 

in which you wish to save the image.
NOTE: CorelTRACE saves bitmap images as Windows bitmaps and assigns them the BMP 
extension.



Choosing Tools:
The CorelTRACE tools are located in the vertical toolbox on the left hand side of the screen. They allow 
you to perform various operations such as color selection and zoom.    Please see the Tools section for 
more information    about each tool. 

To choose a Tool with the mouse:

· Click the tool with the left mouse button.



 Working with menus
The menu bar show the names of five drop-down menus.

To choose a menu command:

1. Click the menu name with the left mouse button.    The list of commands for that menu 
appears.

2. Click the command with the left mouse button. The selected action is performed or a 
dialog box appears asking you to provide CorelTRACE with more information.    See the 
menu section of Help for information about menu commands.



Working with roll-up windows
Roll-Up windows provide quick access to many features in Corel applications.    Roll-Up 
windows remain on-screen as long as you need them to be there and, as their name implies,
can be rolled up and down allowing you to free up some space on the desktop without 
having to close the window.

To roll a window up and down:

· Click the arrow in the top right corner of the roll-up; or click on the control menu and
choose Roll up or Roll down.

To close a Roll-up:

· Click the control menu and choose Close.
To move a Roll-up:

· Point to the Title Bar, and hold the left mouse button down and move to the new 
location.



Working with dialog boxes
When CorelTRACE requires information to carry out a command, it displays a dialog box.

To set options in a dialog box, do one of the following:

· Click on the option with the left mouse button.
· Hold down the ALT key and press the underlined character in the option name.

To select an item in a list box, do one of the following:

· Click the scroll arrows to display the option you want, click on it with the left mouse 
button.

· Hold down the ALT key, press the underlined character in the list name, press    or    to 
highlight the option you want.

To select an item in a drop-down list box, do one of the following:

· Click the down arrow, then click the option with the left mouse button.
· Hold down the ALT key, press the underlined character in the list name, release the ALT

key, then press    or    to highlight the option you want.
To type in a text box:
If the text box is empty, do one of the following:

· Click on the text box and begin typing.
· Hold down the ALT key, press the underlined letter in the text box label, then begin 

typing.

If the box contains text, do one of the following:
· Hold down the left mouse button, move the mouse pointer over the text you want to 

replace, the start typing.
· Hold down the ALT Key, press the underlined letter in the text box label, then begin 

typing.
To edit a text box:
Do any of the following:

To Do this
Move insertion point Click on the new location, or press the    ,, HOME or 

END key.
Select text Drag with the mouse, or hold down the SHIFT key 

and press the ,, HOME or END key.
Delete text Press the BACKSPACE or DEL key to delete one 

character at a time or select the characters and 
press the DEL key.

Replace text Select text and begin typing.



To carry out the options you set:

· Choose OK or press the ENTER key
To close a dialog box without carrying out the options you set:

· Choose Cancel or press the ESC key



Starting and exiting CorelTRACE
Starting CorelTRACE:

Double click on the CorelTRACE icon.    The CorelTRACE screen appears. The tracing tools are
dimmed because they are not available until you have either opened or acquired a file to 
trace.

Exiting CorelTRACE:

To exit CorelTRACE, select Exit from the File menu.    You are prompted to save the current 
trace before quitting if you have not saved the current changes.



Using CorelTRACE Online Help
Help shortcuts keys
Using secondary windows
How to use Context-sensitive Help
Opening other programs' Help files
Keeping Help on top
Using Help's Search feature
Using the History button



How to use Context-sensitive Help
"Context-sensitive Help" is a term used to describe Online Help available for the application 
item you are currently using. 

To open Online Help for the topic you want:

· Press Shift+F1 and use the Context-sensitive pointer  to click the menu item, tool, 
button, or interface item you want information about

· Click the right mouse button on the Toolbox, Ribbon Bar or Text Ribbon Bar
· Press F1 from any open dialog box, or
· Choose a Help item from the Help menu



Using the History button
The History button lists the last 50 Help topics viewed. It provides a useful alternative to the 
Contents buttons.

To use the History button:

1. Press "t" on the keyboard, or click the History button.
2. Scroll through the topics until you find the one you are interested in.
3. Double-click the topic you want to review and close the History window.



Opening other programs' Help files
You can open Online Help files for other Windows application using the Help File Menu. This 
procedure explains how to open Help for CorelDRAW!

To open CorelDRAW's Online Help:

1. Choose Open from the CorelTRACE Help Menu Bar. 
2. Double click Coreldrw.hlp from the File Name box.

Note: You can open any of the Online Help files for the CorelDRAW suite of 
applications from the Programs subdirectory by double-clicking them in the main 
directory where you installed CorelDRAW, usually \COREL50\PROGRAMS. 



Using Help's Search feature
Help Search keywords are usually limited to specific topic names or subjects. If the topic is 
procedural, the keyword describing it takes you to a Contents screen. From there choose the 
topic you are looking for.

In general, try to use the terms used by CorelTRACE, beginning with subject area in 
searching for help about dialog boxes, menu items or subject areas.

To search for information about tracing images:

1. With a Help window active, press "s" or click the Search Help button.
2. Type the subject are for which you want help in the Search box. A list of topics appears 

in the Show Topics area of the Search dialog box. 
3. Press enter with the appropriate term highlighted in the Show Topics box. The topics 

relevant to that subject appear in the Go To area of the dialog box.
4. Double-click a help topic.



Keeping Help on top
By default, online Help windows remain open but drop out of sight when you click another 
window. You may find it useful to keep Help windows visible while you work.---the smaller 
secondary windows containing procedures are particularly useful this way. (Application 
menus still appear on top of your Help window when called using speed keys.)

To keep a Help window on top:

1. Click the Help from Help Menu Bar in any main Help window.
2. Choose Always on Top.

This causes both main and secondary windows to remain on top. Resize as required.
Notes: You may toggle the On Top command on and off, and minimize on-top Help 

windows to icons. 



Using secondary windows
Secondary Help windows, the smaller windows that appear when you click a procedural topic
title in a Help contents listing, display concise step-by-step Help information. They cover a 
smaller portion of the active application window than main Help windows. And because they 
stay on top, secondary windows make it easier to carry out a procedure and view its Help 
topic at the same time without switching back and forth between windows.

Always on top: CorelTRACE's secondary Help windows differ from main Help windows in 
that they are programmed to remain on top of your current application window until you 
need to close or minimize them. 

The following limitations apply to secondary windows:

Search:  If you use Help's Search function to find a secondary window topic, Help takes you 
to a main menu which includes the procedural topics you are looking for.

Sizing: Unlike other window types in the Windows Operating System, secondary windows do
not "remember" when you change their default size and position. 

To resize a secondary window and retain that size for subsequent topics viewed during the 
current CorelTRACE session, minimize the window rather than closing it when finished. The 
next time you open a topic held in a secondary window it appears in the size and location 
you set for the minimized window.

The Buttons: Secondary window buttons must be clicked with the mouse pointer. 
Secondary windows do not include browse buttons.



Toolbox
Includes the six CorelTRACE tools. These tools perform various functions such as color selection and 
zoom.    Each tool is    described in the Tools section.



Ribbon Bar
The CorelTRACE Ribbon Bar includes buttons that provide quick access to various commands and 
display items such as    the Batch File Roll-Up window and the tracing color box. See The Tools section.



Menu Bar
Includes the drop down menus for CorelTRACE.    The menus contain the commands which 
are described in the Menus section.



Title Bar
The CorelTRACE title bar shows the name of the application plus the name of the bitmap file 
displayed on    the left-hand side of the screen.
The Title Bar may contain the following buttons for controlling the window:

 Maximize button
 Minimize button
 Restore button
 Control Menu box



Control Menu Box
The Control Menu box displays commands for sizing and positioning the CorelTRACE window.



Image Area
This is where the bitmap you wish to trace appears. The bitmap is obtained by using the Open or Acquire 
Image command in the File menu.



Trace Area
This is where CorelTRACE displays the traced image.



Status Line
The status line provides information about the tools or menu commands you are selecting.



Progress Meter
This is where CorelTRACE shows you a progress report when it is in the process of opening, previewing 
or tracing an image.    
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Aspect ratio
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Bitmap
Brightness
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Clipboard
CMYK
Control menu
Control menu box
CorelPHOTO-PAINT
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Directory
Dithered color
DPI
Drive
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File previewer
Four color process
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Gray component replacement (GCR)
Gray-scale image
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HSB
Hue
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image header
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Jaggedness
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Maximize
Menu
Menu bar
Minimize
Monochrome
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Nodes
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Paint program
PANTONE
Process color
Pure color
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Resolution
RGB
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Saturation
Scanner
Spot color
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Tints
Tracing buttons
TRUMATCH
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Vector graphics
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Weight (line weight)
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Mosaic Roll-Up
Displays Corel MOSAIC, a file management application, as a roll-up window in the Corel 
application you are currently using.    The Mosaic roll-up is used to display a collection of 
thumbnails, each thumbnail representing a file. You can use drag and drop to open or import
files displayed in the roll-up, in the application you are working with.

Two Mosaic roll-up windows can be opened at the same time in an application, allowing you 
to move or copy files between collections using drag and drop. 

Control menu box    
Use to roll up, roll down, close the Mosaic roll-up window, arrange all opened roll-up 
windows or close them all.

Directory drop-down list 
Located immediately below the Control menu box, the directory drop-down list allows
you to select or change the directory, library or catalog displayed in the Mosaic Roll-
Up. A file folder icon precedes each directory name in the list, a book icon precedes 
catalog names and a book collection precedes library names.    An open collection, of 
any type, has an open file folder preceding its name.

Open collection button     
Allows you to select or change the directory, library or catalog displayed in the 
Mosaic Roll-Up.    It displays the Open Collection dialog box where you choose the 
type of collection you wish to open; directory, library (.CLB) or catalog (.CLC).    To 
open a directory, select the file type you want to see, All Image Files to see 
thumbnails of all graphic files or All Files to see thumbnails of all files in the 
directory.
The Options button displays additional options to sort files, see notes associated and
keywords associated with them and a Find button to find files that have specific 
keywords.    The keyword options are not available in every Corel application.

Thumbnail size and orientation
The thumbnail size, orientation and other settings used in the collection are the ones 
saved when the standalone mode of Corel MOSAIC was last used.

Drag and Drop to the application
You can import a file into the application by clicking its thumbnail    and dragging it to 
the current document in the application. Files of any files formats supported by the 
Corel application can be imported.

Moving and copying files between collections
You can copy a file to a different collection by clicking its thumbnail and dragging it to
the collection of your choice. Holding down the Shift key while dragging the file 
moves it instead of copying it.



Catalog

A collection type in which thumbnails of your files, along with keywords and pointers indicating the 
location of your files are stored. A catalog does not contain the actual files. It is used to visually group files
that are saved in different directories yet are of related subject matter. 



Collection
A general term referring to master files which contain thumbnails.    The thumbnails are 
associated with files and are displayed in a single window in the display screen.    A collection
can be a library, a catalog or a directory. 

A library contains the actual files it shows as thumbnails in a compressed format.    A 
directory contains the files in an uncompressed format. A catalog contains only references 
pointing to files located in various directories and keywords associated them. 



Batch Operations

A task performed on several consecutive graphic files.    Batch printing, importing, 
exporting/converting and extract/merge-back text are available in Corel MOSAIC 
(standalone).



Library

A type of collection in which individual graphics files are stored in a compressed format.



Thumbnails

Small bitmap representations of graphic files created and saved with original drawing files. Thumbnails 
are used within Corel MOSAIC as a way of organizing, displaying, and selecting graphics files visually 
rather than by filename. 



Corel MOSAIC
A versatile file management utility included with CorelDRAW 5. Corel MOSAIC works in one of
two modes; standalone or roll-up.    The standalone mode, accessed by double-clicking the 
Corel MOSAIC icon in the Corel Applications group, provides full functionality.    It allows you 
to create collections, perform batch operations to graphics files, export files, to name just 
few.    

The roll-up mode displays MOSAIC as a roll-up window within another CorelDRAW 
application. It provides basic functionality by giving you quick access to graphic files and 
allows you to use drag and drop to import or open files within the application.



Using the Mosaic Roll-Up
Opening collections
Resizing the Mosaic roll-up window
Importing files using drag and drop
Moving/copying files between collections



Opening collections
The Mosaic Roll-Up command allows you to open collections of thumbnails of graphic files.    
The thumbnail representation of the files makes it easy and fast to select and manage your 
graphic files.

You can have two Mosaic roll-up windows displayed in any Corel application.    This is useful 
when you need to import files from different collections or move/copy files between 
collections.

To choose a collection:
1. Choose Mosaic Roll-Up in the File menu.    The Mosaic roll-up window appears and displays 

thumbnails of a directory's files. 

2. Click . The Open Collection 
dialog box appears.

3. In the Open Collection dialog box, choose a file type in the List Files of Type drop-down list box 
from one of the following:

· .CLC to open a catalog file 

· .CLB to open a library file

·    another file format in the list to open a directory; only the files of the chosen format appear.

· All Files or All Image files to display files of any format/any graphic format, included in the 
selected directory.

4. The thumbnails of the graphic files included in the collection appear in the roll-up window. Files 
saved in a file format not supported by Mosaic are listed but a large "X" appears instead of a 
thumbnail.

5. Repeat steps 1-3 to open a second collection.



Resizing the Mosaic roll-up
You may want o resize the roll-up in order to see more thumbnails at one time.

To resize the Mosaic roll-up window:
1. Position the cursor over the horizontal or vertical window border of the Mosaic roll-up window.    

The cursor changes to a double arrow indicating both directions in which you can move the 
border.    

2. Click and drag the window border until the window is of the desired size.    If you drag the window 
border from a corner, the double arrow is diagonal and allows you to resize the roll-up window 
horizontally and vertically at the same time.



Opening image files using drag and drop
The Mosaic roll-up makes it very easy to open image files in CorelTRACE with the use of drag
and drop.

To import files in a Corel application using the Mosaic roll-up:
1. In CorelTRACE, choose Mosaic Roll-Up in the File menu.

2. If needed, change the current collection by choosing one in the directory drop-down list.

3. Click the thumbnail of the file you want to open. The thumbnail is highlighted.

5. Press and hold down the mouse button, drag the cursor to the image area in CorelTRACE and 
drop it by releasing the mouse button.

6. The file associated with the thumbnail appears in the image area and is ready for tracing. 



Moving and copying files using drag and drop
You can open two Mosaic roll-up windows in a given Corel application.    Using drag and drop, 
you can copy or move files between collections displayed in the roll-up windows.

To copy or move files using drag and drop:
1. In a Corel application, choose Mosaic Roll-Up in the File menu.

2. Choose a collection.

3. Repeat steps 1 and 2 to open a second collection.

4. Click the thumbnail of the file you want to move or copy. The thumbnail is highlighted. Press the 
Ctrl key and click to select multiple thumbnails.

5. Press and hold down the mouse button, drag the cursor to the other Mosaic roll-up and drop it by 
releasing the mouse button to copy the file.    Press the Shift key before releasing the mouse 
button to move the file.

6. A dialog box appears asking you to confirm the move or copy operation.



Open Collection (File menu)
Opens an existing collection (catalog, library or directory) containing graphic files for viewing in the roll-
up window.

The command displays thumbnails of the graphics files included in the collection in the file 
display screen. If a file is not a graphic file, but is a file type recognized by Corel MOSAIC, the
icon representing the program it was created in is displayed.

indicates that the file is in a format that Corel MOSAIC does not recognize. If 
CorelDRAW supports the format, you can still import, export and print the file.
You can search for specific files by keywords and choose the order (by name or date) the images will be 
displayed in.

Several collections can be opened at the same time in Corel MOSAIC, allowing you to move or copy files 
between them using drag and drop.

Dialog Box Options

File Name
Displays the files of the selected file type contained in the current directory.    It also lists all 
catalogs or libraries in the current directory. Double-click a collection name and all thumbnails for 
the files within the collection display in the display screen.

Directories
Displays a list of directories for selecting catalogs, libraries and directories. Double-click on a 
directory to display the related sub directories and to list all file names of a given format in the 
File Name box. 

List Files of Type
Displays the file formats available for selection, which include Catalog File(.CLC), Library 
File(.CLB),and supported file formats for all the CorelDRAW applications. When opening a 
directory, choose a specific file type to have only files of that type display in the display screen.    
All Files displays all files included in a directory and All Image Files displays only files of a 
graphic nature.

Drives
Lists the drives available for selection.

Preview
When enabled, shows a thumbnail image of the graphics file highlighted in the File 
Name box.

Options >>
Displays additional options for searching and sorting files.

Tip
When viewing a collection containing many files, clicking the window as the files are 
being loaded halts the display. When ready to continue, pressing the ESC key 
resumes the display.



Open Collection Options (File menu)
The following options appear when the Options >> button is clicked in the Open Collection 
dialog box.    Their purpose is to search a collection for files that contain specific keywords 
and display their thumbnail images in the display screen. The keywords are saved with the 
original file, in the application used to create it. Not all Corel applications support the use of keywords.

Dialog Box Options

Sort by Options for sorting files by their file name or date. Both the files listed in the dialog 
box and the thumbnails in the display screen are sorted according to the chosen 
Sort by option.

Subdirectories When selected, Corel MOSAIC searches the current directory and all subdirectories 
below it for graphics files of a specified file format. 

Keywords Displays the indexing terms associated with the selected file. 

Notes Displays the annotations associated with the selected CorelDRAW file.

Fonts Displays the names of the fonts used in a selected CorelDRAW file.

Find Searches a directory for CorelDRAW files that contain specific keywords and 
displays their thumbnail images in the display screen. 

Tip
When viewing a collection containing many files, clicking the window as the files are 
being loaded halts the display. When ready to continue, pressing the ESC key 
resumes the display.





How to...
Open an image
Open a resampled image
Open a cropped image



How to...
Trace multiple images
Add files for batch tracing
Remove a file from the Batch Files list



How to...
Save a traced file
Save a bitmap image
Save traced text 



How to...
Scan images



How to...
Edit an image in CorelPHOTO-PAINT



How to...
Trace an image: The Basics
Stop the tracing process
Choose the appropriate tracing method



How to...
Create custom tracing settings
Select custom tracing settings



How to...
Save a traced file



How to...
Open a collection
Resize the Mosaic roll-up window
Open image files using drag and drop
Move/copy files between collections






